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Dear Reader,

Thank you for choosing Introducing Mudbox. This book is part of a family of premium-

quality Sybex books, all of which are written by outstanding authors who combine 

practical experience with a gift for teaching.

Sybex was founded in 1976. More than 30 years later, we’re still committed to produc-

ing consistently exceptional books. With each of our titles, we’re working hard to set a 

new standard for the industry. From the paper we print on, to the authors we work with, 

our goal is to bring you the best books available.

I hope you see all that reflected in these pages. I’d be very interested to hear your com-

ments and get your feedback on how we’re doing. Feel free to let me know what you think 

about this or any other Sybex book by sending me an email at nedde@wiley.com. If you 

think you’ve found a technical error in this book, please visit http://sybex.custhelp.com. 

Customer feedback is critical to our efforts at Sybex. 

	 Best regards,

	  

	 Neil Edde

	 Vice President and Publisher

	 Sybex, an Imprint of Wiley



To Erin, William, Jacob, and my parents—love always and forever



This book is a result  of many deliberate and accidental events, 

and there are many people to thank and acknowledge for their involvement in 

making these events happen. If it weren’t for them, you wouldn’t be reading this 

book.  ■  A very special and heartfelt thanks to my parents for their love, dedica-

tion, faith, and support over the years. Thanks to my dear soul mate, Erin, for her 

encouragement, understanding, and devotion while I worked on the book. Thank 

you to my dearest sons, William and Jacob, for letting me see life as I had never 

seen it before; I hope this book is the start of my being able to do the same for 

you.  ■  Another person pivotal to making this book possible is a dear friend and 

fellow trench mate, Eric Keller. As a classmate, he asked to include an image of one 

of my ZBrush digital sculptures in his book Introducing ZBrush (Sybex, 2009), and 

it started a friendship that continues to grow.  ■  This book would not have been 

possible without Mariann Barsolo, who asked me to take the leap and write it, and 

then rode shotgun throughout the process. I would also like to thank Mariann for  

putting together an excellent team to work with me. Thanks to Keith Reicher 

for serving as technical editor and providing information about the Mac-specific 

features of Mudbox, and to Lisa Bishop for being an excellent development edi-

tor. Thanks to Liz Britten for her magic touch as production editor, and for letting 

me see the content in book form rather than a Microsoft Word file and a bunch 

of images. Thanks to Ryan Sneed for his cover design. Thanks to Sharon Wilkey, 

copy editor, and all of the wonderful people at Sybex/Wiley who were involved in 

the production of this book. Finally, a special thanks to Neil Edde, publisher, and 

Pete Gaughan, editorial manager, for their involvement in the synchronicity of this 

book coinciding with the release of the 2011 version of Mudbox.  ■  I was elated 

and surprised when one of my favorite artists, and constant source of inspiration, 

Ashley Wood, responded to an email I sent asking to use his robot creation Bertie 

as the subject of the exercises in Chapters 1, 3, and 4. I would like to extend my 

extreme gratitude to him for allowing us to use it. To model Bertie in 3D was a very 

cool experience, and it is my hope that your work with Chapters 3 and 4 will cre-

ate interesting variations as well. Please note, however, that Bertie is copyrighted, 

and the likeness and files on the DVD can be used only as the subject for the 

Acknowledgments



exercises and for personal education, noncommercial projects.  ■  Thanks to the artists 

Maik Donath, Marcia K. Moore, Kenichi Nishida, Andreja Vuckovic, Rudy Wijaya, and 

Pete Zoppi for contributing work to the Gallery. It is good to know that there are such 

amazing artists creating incredible art with Mudbox. Their work continues to inspire 

me.  ■  Thanks to the original creators of Mudbox, Andrew Camenisch, Dave Cardwell, 

and Tibor Madjar, and the Autodesk team that continues to develop and enhance the 

program. A huge thanks to Dave and Andrew for answering my questions. Also, thanks 

to Brittany Bonhomme, Jodi Anderson, and Elizabeth Garreau from Autodesk for their 

help and support.  ■  Very special thanks to Domi Pitturo and Mimi Tran at Icon Imag-

ing for providing me with the 3D scan data and helping me with the content in Chapter 7. 

It is truly a pleasure and privilege to work with artists so integral to the development and 

implementation of 3D scanning technology. Please note that the scan data for the Chapter 

7 is copyrighted, and the likeness and files on the DVD can be used only as the subject 

for the exercises and for personal education, noncommercial projects.  ■  Big thanks also 

to Dan Gustafson from NextEngine for his help with the NextEngine desktop scanner 

information and images in Chapter 7.  ■  Thanks to Phil Dench at Headus for making 

UVLayout, one of the most brilliant software applications I have ever used.  ■  Thanks to 

Thomas Teger at Luxion for assisting me with KeyShot in Chapter 9.  ■  Thanks to Ofer 

Alon for creating ZBrush and launching the world of digital sculpture.  ■  A huge debt of 

gratitude to Scott Spencer for being an incredible anatomy and advanced ZBrush teacher 

at the Gnomon School of Visual Effects, and writing two indispensable books on digital 

character design and sculpting human anatomy. I feel extremely fortunate to have taken 

your class, and appreciate your feedback on the anatomy of the model in Chapters 7 and 

8.  ■  I also want to acknowledge Kevin Hudson at the Gnomon School of Visual Effects, 

and Rudy Wijaya, lead modeler at shadedbox, for teaching me everything I know about 

polygon modeling.  ■  I want to take this opportunity to thank all my instructors at the 

Gnomon School of Visual Effects: Jeremy Engleman, Ryan Kingslien, Loren Klein, and 

Ergin Kuke, for the excellent education I received in their areas of expertise, and want to 

extend that gratitude to Alex Alvarez for being the beacon of education in this field.  ■  A 

special thanks to Joey Jones from shadedbox for his excellent Maya animation class at the 

Art Center College of Design.  ■  Thanks to my friend Brian, who cured my cabin fever 

by dragging me out to see a movie or have a coffee break in between writing sessions. 



About the Author

Ara Kermanikian  is a freelance character, 

vehicle, and set designer in the entertainment industry. He has 

been working in the field since 2007, after a 22-year career in 

the software industry, 18 of which were at Microsoft as a sys-

tems engineer, engineering manager, and technology director.

He holds a bachelor of science degree in computer science 

from California State University, Northridge, and has stud-

ied numerous courses with leaders in the field such as Scott 

Spencer, Kevin Hudson, Jeremy Engleman, and Joey Jones at 

the Gnomon School of Visual Effects and Art Center College of Design.

Ara has been passionate about building models from his childhood years. His 

exposure to VU-3D on the Sinclair Spectrum fueled his passion for computer 

graphics, which continues to the current day. Ara loves modeling and digital 

sculpting because he can bring characters and images that fuel his imagination 

onto a digital canvas and visualize them in three dimensions.

He has written reviews and master classes for publications such as 3D Artist 

magazine, and has had his work showcased in galleries of several Sybex books.



at   a  glance     CO NTE NT S

Introduction	 ■	 xv

Chapter 1	 ■	 Getting Your Feet in the Mud:  
The Basics of the Mudbox Production Pipeline    1

Chapter 2	 ■	 The Mudbox User Interface    41

Chapter 3	 ■	 Detail-Sculpting an Imported Model    89

Chapter 4	 ■	 Painting and Texturing an Imported Model    125

Chapter 5	 ■	 Digital Sculpting, Part I    151

Chapter 6	 ■	 Digital Sculpting, Part II    179

Chapter 7	 ■	 Working with 3D Scan Data    245

Chapter 8	 ■	 3D Painting    269

Chapter 9	 ■	 Lighting and Rendering    309

Appendix	 ■	 About the Companion DVD    355

Index	 ■	 359



Introduction	 xv

	 Chapter 1  ■  Getting Your Feet in the Mud:  
The Basics of the Mudbox  
Production Pipeline	 1

Understanding the Mudbox  
Workflow Stages	 2

Loading a Base Mesh	 5

Using the Camera to Navigate Your Scene	 5

Blocking in the General Shape and  
Adding Image Planes	 8

Sculpting Your Model   	 13

Adding Paint Layers and Painting  
Your Model	 20

Rendering Your Image in Mudbox	 26

Exporting Results from Mudbox	 28

Rendering Your Image in Maya 	 32

Summary	 40

	 Chapter 2  ■  The Mudbox User Interface	 41

Starting Out with the Welcome Screen	 42

Navigating the Main Viewport	 44

Exploring the East Frame Window	 51

Working with the South Frame Tray	 62

Performing Map Extraction	 78

Setting Mudbox Preferences	 85

Summary	 88

	 Chapter 3  ■  Detail-Sculpting an  
Imported Model	 89

Modeling the Base Mesh	 90

Laying Out UVs	 94

Contents



Using Naming Conventions and  
Organizing the Components of  
Your Model 	 103

Setting Scale, Location, and  
Pose of the Model	 104

Sculpting Surface Details 	 106

Sculpting Weathering and Wear and Tear	 113

Summary	 123

	 Chapter 4  ■  Painting and Texturing an  
Imported Model	 125

Texture-Painting Models in 2D and 3D	 126

Laying Out UV Maps and Arranging UV  
Shells for Texture Painting	 127

Creating Texture Maps	 129

Using Materials and Textures 	 130

Working with Paint and Texture Layers	 132

Using Specular, Gloss, and Bump Maps	 134

Gathering Reference Images	 134

Painting Bertie	 136

Summary	 150

	 Chapter 5  ■  Digital Sculpting, Part I	 151

Understanding Digital Sculpting	 152

Planning the Sculpture	 152

Sculpting in Stages	 154

Determining the Best Base Mesh  
for Sculpting	 155

Understanding the Mudbox Sculpt  
Tools and Their Properties	 157

Summary	 178

	 Chapter 6  ■  Digital Sculpting, Part II	 179

Modeling the Base Mesh in Maya	 180

Laying Out the UVs in UVLayout	 198



Posing the Base Mesh	 207

Sculpting the Model	 225

Sculp Using a Vector Displacement  
Map (VDM)	 236

Summary	 242

	 Chapter 7  ■  Working with 3D Scan Data	 245

Understanding the Benefits and  
Challenges of 3D Scan  Data	 246

Using 3D Scanners	 250

Reviewing Scan Data Import Considerations	 255

Importing 3D Scan Data and  
Re-topologizing in Mudbox	 257

Summary	 268

	 Chapter 8  ■  3D Painting	 269

Painting Your Sculpture	 270

Generating UVs on Subdivision Levels  
and Painting Directly on UVs	 270

Painting on Layers and Using Blend Modes	 274

Using Color, Stamps, and Stencils	 283

Workflow to Adobe Photoshop and Back	 302

Loading Textures into Maya	 305

Summary	 307

	 Chapter 9  ■  Lighting and Rendering	 309

Rendering and Using Cameras in Mudbox	 310

Lighting Your Model	 312

Applying Visual Effects with  
Viewport Filters	 319

Creating Turntables and  
Recording Sessions	 325

Rendering in Mudbox and  
External Programs	 327

Summary	 353



	 Appendix  ■  About the Companion DVD	 355

What You’ll Find on the DVD	 356

System Requirements	 356

Using the DVD	 357

Troubleshooting	 358

	I ndex	 359



Introduction
Digital sculpting  gives you the ability to create anything you can imag-

ine. You can model, paint, and present characters, props, sets and environments in ways 

never before possible. After learning ZBrush, the leading digital sculpting software in the 

industry, I was curious to see what Mudbox had to offer. Upon using the software, I discov-

ered that it provided greater accessibility to artists who were too intimidated by ZBrush’s 

interface, or who wanted to transfer their skills and familiarity with leading 3D software 

packages, such as Maya, to this medium. However, I found limited resources in my search 

to learn about the software, and even though I find the help in Mudbox to be top-notch, 

discovered that there were no books on the topic. I decided to write this book to fill the gap. 

The aim of this book is to be a companion that teaches you the concepts of digital 

sculpting and 3D painting via Mudbox, to produce results that can stand on their own 

or that are part of a workflow. The book is organized to teach you the concepts in waves. 

Chapter 1 takes you through the pipeline and gives you an idea of the workflow, and sub-

sequent chapters give you more detail on specific stages of that workflow and expand on 

the requirements, concepts and capabilities of Mudbox.

I recommend going through Chapter 1 and using what you learn there to experiment 

further. When you run into situations where you need to ratchet up the complexity of 

what you are working on, jump to the specific chapter on that topic to get more informa-

tion and exercises. You can also go through the book sequentially to learn the topics, 

because the chapters build on each other. Chapter 2 provides  an in-depth tour of the 

software to help you understand the details of the user interface.

This is a pivotal and exciting time in the entertainment industry, as software such as 

Mudbox and ZBrush can contribute exponential advances to the production pipeline of 

special effects. Revolutionary capabilities continue to be added with every release, and 

the possibilities of what can be visualized with this art form are soon becoming limitless.

I hope this book will fuel your interest in learning about digital sculpting and 3D 

painting with Mudbox and will help you learn the intricacies of how to use it to achieve 

your potential in creating your own visions.

Who Should Read This Book
This book is for digital artists who want to use Mudbox to sculpt and paint high-definition 

digital models, such as characters, vehicles, props, or sets for film, television, advertising, 
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video games, and both 2D and 3D print. Chapter 1 uses a simple exercise to run through 

the Mudbox production pipeline. The subsequent chapters delve deeper into these stages 

and produce results that would be required at different stages of the pipeline.

This book is intended for readers with a background in art, and an understanding of the 

basics of 3D space and the basic workings of 3D software. It assumes you to be a sophisti-

cated beginner or intermediate user of Mudbox. The book is mostly focused on Mudbox, 

but also covers other tools such as Maya, Photoshop, UVLayout, and KeyShot. Although a 

basic knowledge of the workings of those tools is assumed, I have also included the results 

from those programs for the various exercise steps if you do not have them available to you.

Mudbox is an artist’s tool, and I cover the topics from an artistic as well as a technical 

perspective. My hope is that upon reading this book, you will have all the answers to your 

questions about the technology and workings of Mudbox to maximize your workflow and 

to focus on creating your art.

What You Will Learn from This Book
This book introduces you to the tools and capabilities of Autodesk Mudbox 2011. You will 

learn the different stages of a production pipeline in which Mudbox is applicable, and the 

workflow of those stages.

You will learn how to start your model from a basic primitive shape, develop it into a 

sophisticated, realistic-looking digital sculpture, and render it using Mudbox, mental ray 

in Maya, and Luxion KeyShot.

You will learn how to import models into Mudbox and to sculpt high-frequency detail 

to give the surface a weathered and realistic look.

You will also learn how to tune surface materials and paint your model in 3D as well as 

how to use paint layers to create composite surface results to further your model’s realistic 

representation.

You will learn about planning your sculpture and taking it through the various stages 

such as posing, laying out UVs, and sculpting on various subdivision levels while custom-

izing the Mudbox sculpting tools to get the results you want. I also cover the basics of 3D 

meshes and UVs and how to troubleshoot and optimize their use in your Mudbox workflow. 

You will learn how to import 3D scan data and how to use Mudbox to extract the details of 

the scan and place them on geometry you can sculpt and paint.

All the content on the DVD was specifically created for the purpose of demonstrating 

the concepts in the chapters. I greatly enjoyed creating this content and hope you get the 

same enjoyment in sculpting and painting your own creations.
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Hardware and Software Requirements
To complete the exercises in this book, you will need Mudbox 2011 and a computer that 

meets the systems requirements listed for Mudbox on the Autodesk website.

I highly recommend that you pay close attention to the requirements for the video 

card, making sure you that you are using a certified video card for Mudbox. Mudbox uses 

OpenGL as its rendering engine, and you need a video card that will accelerate OpenGL. 

Certified Nvidia Quadro or AMD FireGL cards are your best bet.

The next most important hardware requirement is memory. As you subdivide your 

models, the memory requirement to store and process them also grows. Even though the 

system requirements mention 2GB, I highly recommend you have at least 4GB, if not 8GB 

or 16GB of RAM if you can accommodate for it.

The next important requirement is the operating systems, which are linked to the pre-

ceding memory requirement. You can use Mudbox in Windows XP, Vista, or 7, or on Mac 

OS X 10.6.2. The Mudbox interface is mostly identical in all of these; however, you prob-

ably want to use Mudbox on the 64-bit version of these operating systems because 32-bit 

operating systems can only access 4GB of RAM. With the 2011 version, Mudbox exclu-

sively works in 64 bits on the Mac, so if you are on version 10.6.2 and above, you probably 

have the required Core 2 Duo or newer processor to support Mudbox. In Windows, you 

need the 64-bit version of Windows XP, Vista, or 7 and an Intel EM64T processor or an 

AMD Athlon 64 or AMD Opteron processor.

Make sure you also have plenty of hard disk space because, in addition to taking up a lot 

of memory, Mudbox models, which could easily be made up of multimillion polygons, also 

take up hard disk space when you save them.

Finally, you need a digital tablet, such as a Wacom Intuos or Cintiq, based on your pref-

erence of having the tablet functionality detached or superimposed on the screen you are 

working on. Although you can follow the exercises in this book by using a three-button 

mouse, I have yet to see someone who is a proficient digital sculptor and 3D painter use 

just a mouse to achieve good results.

How to Use This Book
The chapters in the book are organized in a sequential manner;  the content of latter chap-

ters builds on the concepts introduced in earlier ones to help you delve deeper into the 

topic. The chapters are also broken up by topic, so you may jump to any chapter that per-

tains to the topic with which you need immediate help. Much thought was given to which 
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chapter exercises would be best accompanied with videos to help you watch the sequence 

of the exercise steps as a movie clip.

All of the topics are augmented and supported with artistic concepts such as form, ges-

ture, proportion, rhythm, balance, and composition.

The book also has a full chapter dedicated to lighting and rendering your model in 

Mudbox, as well as in mental ray in Maya and in a top-notch rendering software called 

KeyShot.

Chapter 1, “Getting Your Feet in the Mud: The Basics of the Mudbox Production 

Pipeline,” runs you through the pipeline by creating a model of an egg and giving it the 

surface texture of an eggshell. Then you will paint it to have the material and texture of an 

egg. Finally, you will view your output in Mudbox, or export your work to Maya and ren-

der it in mental ray.

Chapter 2, “The Mudbox User Interface,” gives you an in-depth tour of the interface of 

Mudbox with explanations of regions, panels, icons, tools, dialog boxes, and options.

Chapter 3, “Detail-Sculpting an Imported Model,” goes through an example of import-

ing an intricate model and using Mudbox to sculpt real-world wear and tear in fine detail 

on the surface of the model.

Chapter 4, “Painting and Texturing an Imported Model,” takes the work you did in 

Chapter 3 and allows you to apply paint to the surface features to push the realism of the 

model further.

Chapter 5, “Digital Sculpting, Part I,” goes deeper into digital sculpting concepts, such 

as the foundation of 3D models, and the stages they would need to go through in Mudbox. 

The chapter also covers advanced sculpting techniques and delves deeper into the sculpt-

ing tools and their properties.

Chapter 6, “Digital Sculpting, Part II,” builds on the previous chapter with the incep-

tion of a base mesh model in Maya, for which you will then create UVs in UVLayout, and 

pose it and sculpt it in Mudbox.

Chapter 7, “Working with 3D Scan Data,” is the final sculpting chapter. Here you will 

learn how to import a 3D scan of a human head into the software and run through the 

workflow of further sculpting it.

Chapter 8, “3D Painting,” focuses on the second core capability of Mudbox: painting. 

You will learn more about the paint tools in Mudbox while painting the model you created 

in Chapter 6.

Chapter 9, “Lighting and Rendering,” provides you with in-depth information on 

how to use the lights in Mudbox in addition to the viewport filters, which enhance the 
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presentation of the model you are working on. The chapter also covers how to export 

images of your work and composite them in Photoshop, and how to export your model 

and textures to render it with mental ray in Maya and in KeyShot. 

The Companion DVD
The companion DVD includes all the files in the lessons saved at several stages along the 

process. It is organized by folders for the nine chapters, in addition to a Stamps folder, a 

Stencils folder, and a 3D Primitives folder that contain 2D images and objects you can use 

for the lessons or future projects. Some chapters include a Videos folder that has movies of 

some of the lessons and some bonus movies related to the topic of the chapter. All the video 

files were recorded using TechSmith Camtasia using the H.264 codec. Because Mudbox 

scene files tend to get big when you subdivide a model into multimillion polygons, we have 

compressed the chapters as zip files. You can use tools such as WinZip or 7-Zip to uncom-

press these files. Please copy and uncompress the contents of the chapter you are working 

on from the DVD onto your hard drive before proceeding with the exercises. The head scan 

model on the DVD is provided by Icon Imaging. The Bertie robot model on the DVD is 

based on paintings and comic books by Ashley Wood. Both models are to be used for edu-

cation purposes only. Commercial use is not allowed.

Essential Mudbox and Digital Sculpting Resources
The most essential resource of all is the community website built right into the software 

under the Mudbox Community tab. There you will find tutorial videos to take you beyond 

the offerings of this book, and demonstrate the work styles and tips and tricks of talented 

artists.

Another useful resource is the Autodesk AREA website (http://area.autodesk.com), 

which is a superset of what is included within the Community tab in Mudbox covering 

some of the other Autodesk products such as Maya, 3ds Max, and Softimage.

It is impossible to talk about Mudbox without mentioning Wayne Robson and his com-

munity website, Mudbox Hub (mudboxhub.com). Here you can find additional tutorials, a 

forum dedicated to Mudbox, and some useful plug-ins.

It is also impossible to talk about Mudbox without mentioning PixelCG and Ashraf 

Aiad’s blog (www.pixelcg.com/blog). Here you can find some indispensible tutorials on 

Mudbox, as well as the extremely useful process of adding the environment variable to 

disable LZW compression on .tif files saved out of Mudbox to be used in mental ray.
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Another thriving and excellent community for digital sculptors is ZBrush Central 

(www.zbrushentral.com). Although it is mainly aimed at ZBrush users, you can find some 

excellent techniques and inspiration from expert and seasoned digital sculptors.

As for resources on art and sculpting, there are too many to mention in this section, but 

I will list a few that I have within arm’s reach at all times for reference and inspiration.

Anatomy Essentials

Modeling and Sculpting the Human Figure•	  by Edouard Lanteri (Dover Publications, 1985)

Female and male anatomy reference figures from •	 www.AnatomyTools.com

Lighting and Rendering

Digital Lighting & Rendering, Second Edition•	  by Jeremy Birn (New Riders, 2006) 

Lighting & Rendering in Maya: Lights and Shadows•	  DVD by Jeremy Birn

Online Learning and DVDs

Gnomon Workshop online and DVD training at •	 www.thegnomonworkshop.com

How to Contact the Author
I would love feedback from you regarding the content in this book, or future titles and top-

ics you would like to see. Please feel free to contact me at kermaco@live.com. For more infor-

mation about me or my work, visit www.kermaco.com.

Sybex strives to keep you supplied with the latest tools and information you need for 

your work. Please check their website at www.sybex.com or the website for this book at  

www.sybex.com/go/intromudbox, where we’ll post additional content and updates that sup-

plement this book should the need arise. 

Thank you for your support in purchasing this book. It has been a great adventure writ-

ing it and figuring out relevant exercises for you to understand the foundation concepts 

and the workings of Mudbox 2011. When I set out to learn Mudbox, there were no books 

on it. I hope that I have bridged that gap for you in a way that is helpful, and that the con-

tent builds a good foundation for you to create your artwork by using the amazing capa-

bilities that the developers of Mudbox have put in our hands.
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Getting Your Feet in the Mud:  
The Basics of the Mudbox 
Production Pipeline

Digital sculpting  and 3D painting software is a relatively recent and 

significant milestone in computer graphics imagery (CGI). Audiences expect more and 

more from special effects that suspend their disbelief when the most extreme visions 

of an author’s imagination are brought to visual reality. As movie directors and game 

designers push the envelope to meet the demands of the market, tools such as Mudbox 

are becoming a requirement in every visual effects production pipeline.

Mudbox is a sophisticated digital sculpting and painting software package that lets 

artists sculpt and paint digital models using software as their modeling clay or paint-

brush. Mudbox enables you to create the realistic and detailed characters, props, vehicles, 

and sets that satisfy the audience’s expectations. The artists’ imagination and creativity 

are fast becoming the only limits to what they can show their audience.

This is the most important chapter in the book because it introduces all the concepts 

and stages models go through in the production pipeline. After learning this pipeline and 

the concepts, you will be ready to delve into the rest of the book, so make sure you are 

comfortable with this chapter’s contents, even if you have to go back through the steps 

before moving on.

This chapter includes the following topics:

Understanding the Mudbox workflow stages■■

Loading a base mesh■■

Using the camera to navigate your scene■■

Blocking in the general shape and adding image planes■■

Sculpting your model■■

Adding paint layers and painting your model■■

Rendering your image in Mudbox■■

Exporting the results from Mudbox■■

Rendering your image in Maya■■
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Understanding the Mudbox Workflow Stages
Mudbox is used throughout the multiple stages of a production pipeline (Figure 1.1). It 

is used for speed-sculpting concept designs, digital sculpting art assets such as charac-

ters, sets and props, painting models, sculpting blend shapes for animation, and projec-

tion painting environments. Although these seem like completely different stages, the 

Mudbox work is fairly similar, so as you get a good grasp of what the software can do, 

you can apply it to any of the stages in the pipeline, or come up with completely new 

areas where Mudbox could help your project.

Mudbox can be used as a stand-alone application, enabling a user to start with one 

of the provided primitives and end up with a fi nal render of a sculpture. However, most 

artists use it in a production pipeline in which inputs fl ow into the program, and outputs 

fl ow out to 3D and 2D applications. The data fl owchart (Figure 1.2) demonstrates this 

sequence. 

The starting point of Mudbox is a model. This model can be one of the provided 

Mudbox starter meshes, or a primitive or base mesh model you generate in a 3D program 

such as Maya, or a scan from 3D digital scanner. You can also import 2D images to use as 

textures, stamps, or stencils.

In Mudbox, you pose, sculpt, and detail the geometry of the model, and then use 

the 3D painting capabilities to texture and paint it. Mudbox includes some rendering 

capabilities—such as lighting based on high dynamic range imaging (HDRI) and ambi-

ent occlusion (AO)—which give you a good idea of what your model will look like when 

output to an external renderer.

Figure 1.1
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After you are fi nished with your model in Mudbox, you will output the following fi les:

A lower-subdivision-level version of your sculpted model, which has polygon counts •	

that the intended 3D application or game engine can support. These models have the 

overall shape of your final sculpture but lack the detail. These are exported as .obj or 

.fbx files.

Two-dimensional images, called •	 normal and displacement maps, to wrap around 

the lower-resolution version of your model that you exported as an .obj or .fbx file. 

These 2D images give the illusion of the detail you had on the high-subdivision-level, 

Figure 1.2
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high-polygon-count sculpture but require significantly less computing resources to 

render and animate.

Two-dimensional images of all the paint layers that you painted your sculpture with, •	

to composite onto your final deliverable.  

Before moving to the next stages, I recommend you take some time to go through the 

five one-minute movies that come with Mudbox. You can find them on the Welcome 

screen that comes up when you launch Mudbox. If you closed this screen, you can also 

access the movies through Help ➔ Learning Movies, which brings up a Welcome screen 

for you to click on the movies. These movies will get you started with Mudbox by show-

ing you how to navigate with a mouse or a tablet, and how to paint and pose.

I can’t stress how important and indispensible a tablet is for digital sculpting and 3D 

painting in Mudbox. Even though it is possible to do the lessons with a mouse, it will be 

extremely tedious if not impossible to get good results. Tablets come with varying capa-

bilities and sizes. Some come with a display that you can directly draw and sculpt on, 

others are wireless, and some have more sensitivity levels. I use the medium-size Intuos4 

tablet from Wacom. 

I will go through how to set up and optimize settings for the tablet in Mudbox, but for 

now, just make sure your tablet stylus buttons are set to Middle Click for the front button 

and Right Click for the back button. To do this for Wacom tablets, make sure Mudbox is 

running, open the Wacom control panel (Figure 1.3), and follow these steps:

	 1.	 Near the top of the dialog box, click the plus sign to the right of Application.

	 2.	 Click Mudbox and then click OK. Notice that Mudbox is added to your application 

list and has a highlight around it, indicating that it is selected.
Figure 1.3

Tablet control panel

	 3.	 Make sure you are on the Pen tab. Click the drop-

down menu that is mapped to the back button and 

choose Clicks ➔ Right Click.

	 4.	 Click the drop-down menu for the front button on 

the stylus and choose Clicks ➔ Middle Click.

	 5.	 Close the Wacom control panel.

If you are using a tablet, henceforth in this book, sub-

stitute a tap of the stylus for clicking the left button of the 

mouse, a tap of the forward button on the stylus for click-

ing the middle button of the mouse, and a tap of the back 

button on the stylus for clicking the right button on the 

mouse. Tap the stylus and drag on the surface of the tablet 

to substitute left-clicking and dragging the mouse.

In the rest of this chapter, you will go through the 

Mudbox pipeline to produce a realistic-looking egg.
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Loading a Base Mesh
A base mesh, or cage as it is sometimes referred to, is a 3D polygonal object that has been 

modeled in a 3D application and saved or exported as an .obj fi le.

To paint this model, we need to unwrap it into 2D before we bring it into Mudbox. If 

an object has been unwrapped and has UV coordinates associated with it, the UV infor-

mation will be included in the .obj or .fbx fi le. Chapters 3, 4, 5, and 6 explain in depth 

what UVs are and how to generate them. For the examples in this chapter, where needed, 

the UVs are done and provided for you.

To load your base mesh into Mudbox, follow these steps:

 1. Load Mudbox.

 2. Close the Welcome screen by clicking the Close button.

 3. Choose File ➔ Import.

 4. Open the bertie_low.obj file in the Chapter 1\Bertie folder on your DVD.

T h E ar T O F a S h lE y WO O d

Bertie is a robot that can be found in Ashley Wood’s paintings and graphic novels. I have 

been inspired by Ashley’s work over the years and thought Bertie would be a perfect subject 

for sculpting details and 3D painting because of the bold shapes and amazing aesthetic of 

the robot. You will be working more with Bertie in Chapter 3, “Detail-Sculpting an Imported 

Model,” and Chapter 4, “Painting and Texturing an Imported Model.” To see more of Ashley’s 

work, go to his website at www.ashleywoodartist.com. (Please note that the Bertie images, 

and Bertie Maya and Mudbox models on the DVD are provided for your personal education 

only, and not for use in any commercial projects.)

Using the Camera to Navigate Your Scene
Now that the base mesh is in Mudbox, you can look at it from any angle and zoom in 

and out to enlarge areas you will be working on in depth. When you are performing the 

following actions, you are not moving the object but rather the camera through which 

you are looking at the object. This is similar to framing, let’s say, a statue in a museum, 

in the viewport of a point-and-shoot digital camera. You point your camera at the statue, 

and walk around it while using the zoom features to perfectly frame the feature you wish 

to capture in the camera’s display viewport before taking the snapshot. Becoming comfort-

able with navigating the camera is critical to your workfl ow. Practice as long as you need to, 

until you are comfortable getting to the area you need to manipulate with minimal steps.

To work with the camera, follow these steps:

 1. Press and hold down Alt and tap and drag your stylus tip on the tablet to tumble or 

spin the model; with a mouse, hold Alt while left-clicking and dragging.

T h E ar T O F a S h lE y WO O d

Bertie is a robot that can be found in Ashley Wood’s paintings and graphic novels. I have 

been inspired by Ashley’s work over the years and thought Bertie would be a perfect subject 

for sculpting details and 3D painting because of the bold shapes and amazing aesthetic of 

the robot. You will be working more with Bertie in Chapter 3, “Detail-Sculpting an Imported 

Model,” and Chapter 4, “Painting and Texturing an Imported Model.” To see more of Ashley’s 

work, go to his website at www.ashleywoodartist.com. (Please note that the Bertie images, 

and Bertie Maya and Mudbox models on the DVD are provided for your personal education 

only, and not for use in any commercial projects.)
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 2. To pan, press and hold down the Alt key and the forward button on your stylus, and 

hover the stylus over the tablet without touching it. The equivalent movement with a 

mouse is holding Alt while middle-clicking and dragging.

 3. To zoom in and out of your model, press and hold down the Alt key and the back 

button on the stylus, and hover the stylus over the tablet without touching it. 

The equivalent movement with a mouse is holding Alt while right-clicking and 

dragging.

 4. Press W to show or hide the wireframe on the model. 

 5. To focus on a specific area, point to it with the cursor and press the F key on your 

keyboard. Now tumble around as you did in step 1, as you can see the center of 

your rotation is now your focus point. This is a handy way to set the focus on your 

work area.

 6. To see all of your model, press the A key.

 7. From the Window menu, choose Object List (see Figure 1.4). The Object List shows 

you all the cameras, lights, objects, and materials in your scene.

 8. Notice that you have four default cameras already available to you. If you use other 

3D applications, you are usually looking at your object in four views (Figure 1.5). 

In Mudbox, you work in only one viewport. You can switch from one camera to 

another by right-clicking the appropriate camera with your mouse, or by pressing 

the back button on your stylus, and selecting Look Through from the drop-down 

menu. Look through all four cameras.

 9. Notice that as you select a camera, the properties of that camera are displayed below 

the Object List in the Properties tray (Figure 1.6). 

Figure 1.4

Object List
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Figure 1.5

Four viewports as seen in Maya

Figure 1.6

Camera properties

 10. Look through the Front camera. Use the navigation methods I explained earlier 

to move around your model. Now look through the Top camera. Look through 

the Front camera again. You will notice that you are not looking at the model in the 

front view, but the view you actually left your model in. To get the camera to snap 

back to the front view, in the Transform properties of the camera, select the Roll, 

Rotate, Track, and Dolly check boxes and click the Reset button (Figure 1.7). This 

reverts your model to the original front view.

 11. Note that there are three lock options in the Transform properties of your 

camera: Lock Pan, Lock Rotate, and Lock Zoom. When you want to restrict 

any of the three transform capabilities of the camera either for convenience 

or because you have attained a desirable camera view state, you can lock the 

change in the camera position, orientation, and magnification by choosing 

one, two, or three of these options. Note that the Front, Side, and Top cam-

eras have the Orthographic option selected by default, which means they do 

not show your objects with any perspective depth. Experiment by navigating 

around your model with these options to get an idea of how they work.

Figure 1.7

Resetting the 
camera view
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WO r K pl aC E h i N T 

When I sculpt, I usually bring up a second Object List window (by choosing Window ➔ Object 

List) that I can move anywhere on the screen. I usually have this second Object List either on 

my second monitor or somewhere on my fi rst monitor but out of the way of my sculpting. 

I then make sure the Lock Rotate option on all three of the Front, Side, and Top cameras is 

selected, which it should be by default, unless they were changed in a prior session. This helps 

me not to confuse the camera I am looking through, and even if I pan and zoom the camera, 

I am still looking at the model in the view that corresponds to the name of the camera.

You have now navigated the 3D view with your tablet or mouse and the Alt key. The 

introductory movies in the Welcome screen give an excellent demonstration on how to 

do this. Table 1.1 is a cheat sheet to get you started, but this will become second nature 

for you after your fi rst few sessions.

A C t I O N t A B l e t M O u S e

Tumble or spin Alt + click down and drag stylus Alt + left-click and drag mouse
Pan or track Alt + forward button and drag stylus Alt + middle-click and drag mouse
Dolly or zoom Alt + back button and drag stylus Alt + right-click and drag mouse

To focus on an area on your model, move your cursor to it and press the F key.• 

To see all of your model, press the A key. This repositions the camera so all the visible geometry is • 
in the 3D view.

Blocking in the General Shape and Adding Image Planes
Now that you know how to navigate the camera around your model, you will go through 

the entire Mudbox pipeline with a simple example of an egg. You will start with a primi-

tive sphere and then shape it into an egg. You’ll then sculpt the eggshell and paint it. 

Finally, you’ll output displacement, normal, and texture maps to Maya and use mental 

ray to do a fi nal render of the model. 

You can follow these instructions step by step, or watch the movies of this project 

in the Chapter 1\videos folder of the DVD. These videos are divided as follows, based 

on the four stages in the chapter:

 1. Blocking in shape: Chapter1-part1.mov

 2. Subdivide and sculpt: Chapter1-part2.mov

 3. Paint and render: Chapter1-part3.mov

 4. Export and render in Maya: Chapter1-part4.mov

WO r K pl aC E h i N T 

When I sculpt, I usually bring up a second Object List window (by choosing Window ➔ Object 

List) that I can move anywhere on the screen. I usually have this second Object List either on 

my second monitor or somewhere on my fi rst monitor but out of the way of my sculpting. 

I then make sure the Lock Rotate option on all three of the Front, Side, and Top cameras is 

selected, which it should be by default, unless they were changed in a prior session. This helps 

me not to confuse the camera I am looking through, and even if I pan and zoom the camera, 

I am still looking at the model in the view that corresponds to the name of the camera.

Table 1.1

Navigating with the 
Mouse and Tablet


